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November Program:
Tuesday, November 9th, 7 PM.
“Tim’s Timely Tips”

WARNING!
DO NOT INSTALL & RUN
iPhoto version 9 in the new iLife
Suite without first installing iPhoto
update version 9.0.1. Serious

President’s Corner by N.C. Sizemore
Hello everyone,
Shelley and I missed seeing you at the October
meeting and we hear that
we missed a super presentation. I wish we could
have seen it. I understand that Bill Krysalka and
two students gave a dynamite presentation, so
good that maybe I will try to get them to do it
for another organization I’m in so we can see
it. We were out because Shelley had a new left
shoulder joint installed on the day prior to the
meeting. This was done in Tampa, so I could not
even sneak out long enough to say ‘hi” to you.
Her shoulder is doing great and we expect to
be at the November meeting. A big thank you
to Phil for running the meeting for me.
The November program will be “Tim’s Timely Tips” by Tim Rankin. This should be another
program that will be helpful to all of us because
Tim knows some good stuff! He was my mentor when I bought my first MAC. His knowledge
and patience brought me along to the point
where I have not even considered going back to
the PC after the first few weeks 7 years ago.
In Apple news since the last meeting: A new
Macbook AIR with more power and even lighter with all solid state memory in all models. A
new iLife (covered extensively elsewhere in this
newsletter, a new Microsoft OFFICE 11 for MAC
(but be very wary if you might intend to install
this on multiple computers! They have rigorous

advanced protection on the MAC version of this
package: click here for details.
Apple has announced the next version of
OS X. It is called Lion and will be available sometime next summer. click LION for the whole
Lion preview story.
In other club news; The second MAC Workshop hosted by Phil overflowed the space
available in the library and we have moved
the location for future workshops to the same
room where we have our regular meetings at St
George Anglican Cathedral. The Pastor here has
been most gracious to us. Never pass up the
chance to thank him and let’s all continue to remember to be grateful for and respectful of the
room and its contents. I am not aware of any
problems, just wanted to take this opportunity
to remind all of us what a good thing we have
going here. If you check the club web site frequently (and I hope you do) you already knew
about the change of location without a change
of time. Next time: Saturday, November 20th,
10 AM–12 Noon. Check website for details.
Finally, let’s all remember our friend and the
person who arranged for us to use the facilities at the church: Brian Voge. Brian had a hip
replacement recently. I doubt he will be able to
be with us at the November meeting. He might
appreciate a card.
I’m looking forward to seeing you soon.
NCS m

damage to your files can result.

Click here for more info.

Boonana Trojan Horse for Mac OS X spread via social media

“Is this you in this video?” is an all too common question we can find on social networks nowadays.
However, new data from SecureMac says that when you see this and a link to a video, it’s highly
likely that it’s a virus. This trojan—trojan.osx.boonana.a—is commonly spread through this kind of
message on social networking sites, and is capable of affecting many versions of Mac OS X, including Snow
Leopard. When run, the installer modifies system files to bypass the need for passwords. That doesn’t sound like fun
to me. “This is a sobering reminder that hackers are turning their efforts toward Mac OS X as Apple’s marketshare
grows, and users should be vigilant in protecting their computers and taking precautions when surfing the web,” said
Nicholas Ptacek, a security researcher at SecureMac.
Worried you might have this trojan? SecureMac has a free removal tool available on their website— CLICK HERE.
Want to avoid getting it? For one, don’t click any questionable links in social networks.
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Create keyboard shortcuts for the Print
to PDF menu—

Create a Buddy Pic in iChat
from any photo update

Apple software makes it easy to save files as PDF
from almost any program. The problem is that in
order to do so you must click print, then the PDF button, then the “Save as PDF…” button.
Each step requires you to get the mouse in the right place and read the menu. Happily it is easy
to create your own keyboard shortcut that will speed up this process.
Here are the steps—

• Open your Keyboard Shortcuts tab in the Keyboard & Mouse system preference pane.
• Click the “+” sign to add a new shortcut for all applications.
• Then a box pops up asking for the command.
• Type in the Command exactly as it appears: “Save as PDF...” For the ellipses, use the
combination: option + semicolon.

Your Buddy Pic is the picture that
people see when they chat with you
in iChat. Besides getting your Buddy
pic from iPhoto, you can also drag
and drop a photo from any other
source like the Finder, a Mail attachment or a Safari page.
A buddy pic doesn’t have to be a
photograph of you— it can be an
image that represents you or really
any image at all. One of my buddies
currently has a jack-o-lantern on
Halloween.
• Find the photo that you would
like to make into a buddy pic.
• In iChat, go to Buddies / Change
My Picture from the menu bar to
open the Buddy Picture window.
• Drag the photo you want to use
onto the picture area.

• Enter CMD+P in the keyboard shortcut box  (use any shortcut you want, but be careful of
conflicts)
• Click Add
• Done
To use this shortcut
• Enter CMD+P  twice (the first
time brings up the print menu,
the second time sends to PDF)
• Select the folder to save the PDF
• Click Save

You can create shortcuts for the other choices in the menu in the same fashion.
For example: for Mail PDF
 	 • Open your Keyboard Shortcuts tab in the Keyboard & Mouse system preference pane.
• Click the “+” sign to add a new shortcut for all applications.
• Then a box pops up asking for the command.

• Use the slider to zoom the photo
and drag it to move the cropping.

• Type in the Command exactly as it appears: “Mail PDF”

Learn everything there is to
know about Buddy Pics m

• Click Add

FACTOID
Every gmail user actually has two
gmail addresses:

• Enter CTRL+OPT+CMD+M in the keyboard shortcut box
• Done
To use this shortcut
• Enter CMD+P  
• Enter CTRL+OPT+CMD+M

user@gmail.com
user@googlemail.com

• An email message will open up
with the PDF attached

Email addressed to either address
ends up at the same place, but the
difference can be used to create a
filter. One address can be given to
the public and the other to a select
few. m

• Enter the normal email information
(to, subject, etc.)
• Click Send
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Discover Preview’s hidden image editing powers—
by Derrick Story, Macworld.com

Sometimes you just want to tweak an image and move on...
fast. At that moment, you don’t want commitment (iPhoto,
Aperture, and Lightroom), or a bizillion editing options (Photoshop), you just want
to brighten the picture, adjust the color, crop it, and be done..
We have great news for you. This application exists, it’s free, and it’s already on your Mac. It’s
called Preview and many Mac users prefer using Preview for working with PDFs because of its
clean interface and no-nonsense set of tools. What may surprise you, however, is that this
application also has a robust set of imaging tools.
I’m not just talking about double-clicking on a photo and looking at it on your computer.
Beyond that, you can adjust an image’s tonality, color, and even select objects within the shot to
copy and add to other photographs. To prove my point, I’m going to take you on a quick
photographer’s tour of this handy imaging application.
Customize the interface—
A good way to get a feel for the functions available in Preview is to customize the top toolbar. Go
to View -> Customize Toolbar, and you’ll see icons for zooming, selecting, cropping, rotating, and
even scaling. Drag the tools you will use the most often to the top toolbar so they’re ready when
you need them.
Next, go to Preferences (Preview ->
Preferences), click on the General
tab, and click on the radio button
next to “Open groups of files in the
same window.” This allows you to
work on multiple images at once in
Preview.
Test this by selecting a handful of
pictures and dropping them on the
Preview icon. You’ll get a column of
thumbnails displayed in the sidebar
with one image featured in the
main window. You can navigate the
thumbnails by clicking on them individually, or by using the up and down arrow keys. If you want to
add another picture to the line up, just drag it to the sidebar and let go.
Right-click or Control-click in the sidebar and you’ll be presented with options for sorting the
thumbnails or choosing how many columns you want them displayed in. If you don’t like the default
sorting options, choose None from the contextual menu and you can drag the thumbnails in any
order you want.
Batch processing
Batch resampling two images
by selecting them both in the
Preview sidebar.

You can also perform basic
batch processing on multiple images with Preview. Commandclick on two or more thumbnails
in the sidebar, then apply the
rotate command. You’ll probably
want to use the Rotate button
in your top toolbar, but if it isn’t
there, then go to Tools -> Rotate
Left or Rotate Right. The rotation
will be applied to all of the selected images in the sidebar. Bonus tip! If you do use the Rotate
button, you can reverse its direction on the fly by holding down the Option button.

Maybe your images are too big and you want
to sample them down. Command-click on the
thumbnails of the images you want to resample,
then go to Tools -> Adjust Size, and choose the
new dimensions that you want to use for the
photos. Preview will resample all selected images. How’s that for efficiency?
Tonal & color adjustments—
Preview’s Adjust settings when turning a color
photograph
into a black and
white image.

Most photographs could
use a little tonal
or color adjustment, and
sure enough,
Preview
handles those
enhancements
just fine. Bring
up the adjustment inspector by holding down
Option-Command-C, or going to Tools ->
Adjust Color. You’ll be presented with eight
individual controls to help you improve your
photograph. iPhoto has these tools too, so you
may already be familiar with how to use them.
Start by clicking on the Auto Levels button
right below the histogram. More often than
not, this will give you an immediate improvement. Fine-tune the tonal adjustment by
moving the three triangle pointers beneath the
histogram. The left one is for dark tones, the
right is for highlights, and you’ve guessed it,
the middle pointer is for midtones.
Now let’s correct the color. Click on the
eyedropper icon beneath Temperature. This
allows you to auto correct color by then clicking on a white or gray area in the picture. If
you want to fine tune this adjustment, use
the individual Temperature and Tint sliders. In
most cases, Temperature is the more useful
of the two, allowing you to warm up (slide to
the right) or cool down (slide to the left) your
images.
If you want to convert and image to black and
white, move the Saturation slider all the way
to the left. You can color tone the image by
playing with the Temperature, Tint, and Sepia
sliders. This once required lots of work in the
chemical darkroom. Now it’s just plain Mac fun.
Finally, you can add a little sharpening to the
picture via the Sharpness slider. Be careful
not to overdo it here, or you might introduce
unsightly artifacts. Move the slider to the right
about halfway between the midpoint and the
right endpoint. That should suffice in most
cases. You can also soften the image by moving the slider to the left for a dreamy effect. m
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REVIEW:
Photoshop
Elements 9

by Lesa Snider,
Macworld.com
(edited for space)

This simultaneous,
cross-platform release
of Photoshop
Elements 9 marks a
first for Mac users—
the Adobe Elements 9 Organizer is finally available for Mac users and comes packaged with
the hobbyist-targeted photo-editing software.
Windows users have long touted the Organizer’s photo-management and -tagging prowess,
and now Mac owners can take advantage of its
helpful features, including People Recognition,
Smart Tags, and, now, Facebook integration.
(The Organizer also comes packaged with
Premiere Elements 9, which was just released
for the first time ever on the Mac.)
A few other treats have been added to
refreshed Photoshop Elements 9, including a
real layer mask button, a Content-Aware Fill
option for the Spot Healing brush (straight from
Photoshop CS5), and a new PhotoMerge Style
Match option for color and tonal matching.
Meet the Organizer—
The big news with Photoshop Elements 9 is
the addition of
the Adobe
Elements
Organizer—a
separate
photo-management application.
User feedback
drove Adobe’s
decision to
include the
Organizer,
previously
available only in
the Windows
version, with the
Mac version of
Photoshop
Elements 9 in
lieu of Bridge.
Given the
application’s
simplistic
interface and
pared-down options (it lacks Bridge’s pro-level
batch-processing features), it’s a logical switch
considering the Elements audience is made
up of consumers such as photo hobbyists and
digital scrapbookers. (Don’t panic upgraders,

Bridge still works if you already have it or if you
get it later on.)
The Organizer can be used with both
image and movie files, and its tools are broken
up into four clear sections: Organize, Fix,
Create, and Share. There are a few PC-only
features that haven’t yet made the transition
to the Mac version of the Organizer, including
a slideshow-creation tool and the ability to use
geotagging information to map images. But for
the most part, the power is all here:
Importing— The Elements Organizer
makes creating photo albums, adding keyword
tags, searching, and filtering your photos
as painless as possible. It can pluck photos
straight from your camera or card reader,
find existing photos on your hard drive, and
import from iPhoto into the Organizer catalog
(because of the way iPhoto stores photos, the
files are duplicated and a copy is placed in
an Organizer catalog). It’s possible to set up
multiple catalogs in the Organizer if you want
to keep your image library separated.
While importing, you can give photos custom names, save them into new or
existing folders, assign copyright info, create new albums, and more. The easy-to-use
interface lets you import some or all files, as
well as delete photos from the originating
device. The only caveat is that when importing
multiple raw files, you’ll experience a system
slowdown for a couple of minutes as the
Organizer saves multiple image preview sizes.
Smart Tags— The Elements Organizer
makes the chore of keyword tagging less
painful. You can create tags yourself or choose
from a slew of built-in categories; either way,
applying a keyword is a drag-and-drop affair.
Further simplifying the process are Adobe’s
Smart Tags. After you import photos by using
the Elements Organizer, you can have the
Auto-Analyzer engine assess image quality
and contents. For example, it can tags photos as
high, medium, or low quality. Additional Smart
Tags are generated based on elements such as
contrast, lighting, and common objects in the
photos.
People Recognition— The Organizer also
has an algorithm that detects faces. Double-click
a photo, and if the program detects a face, a
box appears asking you who it is. Click the box
and type a name. As you identify people, it
collects the information and begins to suggest
names for faces. When it collects enough data,
it’ll tag photos automatically and ask, “Is this
[enter name]?” You can also ask the Organizer
to scan through your photos and pick faces it
doesn’t yet know. Because the People Recognition feature uses the distance between eyes

in the identification process, it has a tough
time with sunglasses; however, it does remarkably well identifying the same person shot
several years apart.
Editing enhancements—
Layer Mask– At the bottom of the Layer
panel is an actual Layer Mask icon, which lets
you easily hide layer content. The ability to add
a real layer mask saves time and frustration.
Layer masks are crucial for combining images,
head-swapping, making text appear as if it is
hidden behind an item in the background, and
the like.
Content-Aware Fill– The Spot Healing Brush
now includes a Content-Aware Fill option for
removing unwanted objects or other content
from images. The Content-Aware Fill feature,
taken from Photoshop CS5, works by looking
at surrounding pixels and attempting to fill
the area inside the brush with background
content (it does an amazing job as long as the
unwanted content isn’t too close to something
you want to keep).
PhotoMerge– This technology is also summoned in the PhotoMerge Panorama feature,
which all but eliminates the need for excessive cropping of assembled panoramas due
to photo warping (a side effect of aligning
photos). Turn on, “Would you like to fill in the
edges of your panorama?”, and Elements predicts what the missing info is and fills it in for
you. Also new is the PhotoMerge Style Match
feature, which lets you take the stylistic properties of one photo and apply them to another
(think texture, color tone, and brightness).
Guided Edits— If you’re new to image
editing, Photoshop Elements’ Guided Edit
mode shows you the specific tools you need
to execute a certain edit, and gives you
instructions on how to use them. There are
many preset effects including Perfect Portrait
that walks you through skin smoothing, eye
and teeth brightening, and blemish zapping.
And much more— like Quick Edit’s Create
Mode and Fix Mode, Organizer’s Share Mode,
and a backup and synchronization feature.
Macworld Buying Advice
As updates go, this one’s a biggy and
Adobe’s new cross-platform strategy for both
Photoshop Elements, Photoshop Organizer,
and Premiere Elements is a breath of fresh
air. The layer mask button alone makes this a
worthwhile upgrade for frequent users, and
the new Guided Edit modes make it a good
choice for new users. Street price with rebates
is approx. $65.00. Photoshop Elements 9
works on Intel Macs running OS 10.5.8 or
later. m
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OMUG MEMBERS ONLY—
See a list of members and a list of
discounted software and books by going to
the “members-only” section of the website.
If you don’t remember the username and
password, send an email to
p.davis@ocalamug.org. You should NOT
keep entering incorrect information since your
account will be locked out after 5
incorrect “guesses”. When your account is
locked you can’t even get to the OMUG
website. If this happens you should send an
email to p.davis@ocalamug.org to get
instructions for unblocking your account.
m

To my surprise, at the very end of the list was
“Basic Internet” which was free.
The Basic Internet was slower, about half
the speed of my home DSL, but it was fine
for basic web browsing. It stuttered some on a
YouTube video, but for free I wasn’t complaining.
If there is a conclusion to be drawn here,
it would be that accurate information about
the internet access at a specific hotel property
can be hard to find online. If in-room internet
access is a requirement, it would be wise to
call the property directly and inquire as to their
pricing and availability.
If you can’t get or don’t want to pay for
in-room WiFi, most McDonald’s and Starbucks
in the USA now have free wifi. m

Getting Internet Access at Hotels—

Increasing The Size Of Your Mouse
Pointer—

by Chris B. @ Basics4Mac

by Chris B. @ Basics4Mac

It is pretty much expected these days that
hotels are going to have in-room internet
access. Sometimes internet access is free and
sometimes you have to pay for it. It would
make sense that lower priced hotels would
charge the add-on fee for internet access
where a more expensive hotel would offer it
for free. In fact, the exact opposite is true.
I recently took a trip and stayed in a two
different hotels. Both hotels had unexpected
surprises that I would like to share.
The first hotel was a Hampton Inn. Their
own website indicated wireless internet (wifi).
When I checked into the room however, what
I found was an ethernet cable on the desk
and a card stating that guest rooms have wired
internet and only the lobby has wifi.
I haven’t carried an ethernet cable in my
suitcase for many years so I was out of luck.
Besides, we also brought the iPad which
doesn’t even have a way to connect to a wired
connection. I felt pretty mislead by the
information on their website.
The other hotel was a DoubleTree which
is also part of the Hilton chain but higher end.
The DoubleTree’s website indicated in-room
wifi as well but gave no indication if it was free
or for-pay. Following the general rule that more
expensive hotels usually charge for internet
access, I fully expected to pay for it.
On the wifi registration page, it stated that
wifi was $10 per day. Since the price was on
a popup menu, I clicked it to see if there were
other options. Indeed, there was a long list of
price plans for more days and more speed.

I really hate to admit it, but my eyes are slowly
going bad with age. I can still read the
computer screen well enough to get by, but
the one thing I occasionally have a problem
with is locating the mouse pointer.
Even if your eyes are fine, if you are
working on an iMac with a 7” screen or using
multiple monitors, the mouse pointer can
sometimes be difficult to locate.
Fortunately, there is a way to make the
mouse pointer larger to make it easier to see.
To increase the size of the mouse pointer:
1. Go to System Preferences from the Dock
or the Apple Menu.
2. Choose the Universal Access preference
panel.
3. Choose the Mouse & Trackpad tab.
4. About three quarters of the way down,
there is a slider for Cursor Size.
I have found that if you move the slider about
one quarter of the way to the right, you get a
mouse pointer that is large enough to always
find but not too large to get in the way. m

CNET Editor’s Review—
Condensed from a full review by Josh Lowensohn

The bottom line: iLife ‘11 is a welcome, and
long-overdue update to Apple’s suite of digital
media applications. This year’s version adds a
handful of advanced features to iPhoto, iMovie,
and GarageBand without making them more
difficult to use. It’s a shame iDVD and iWeb did
not receive updates with this year’s version,
but with a slightly lower price for upgraders
than in years past, iLife 11 still represents a
good value to consumers looking for a set of
tools for editing and sharing media. At $49,
and close to two years since the last major
update, we can easily recommend this version.
Editors’ note: iLife ‘11 contains upgrades of
iPhoto, iMovie, and GarageBand, but not
iDVD or iWeb.
Setup and interface—
As usual, iLife comes preinstalled on new
Mac computers, so if you just bought one of
the just-introduced MacBook Airs, you already
have the suite. Otherwise, Apple is offering an
up-to-date program that lets recent buyers pick
up the disc at a discounted price. Installation
on our test machine, a recent-model unibody
MacBook, took just less than 20 minutes and
required no extra attention or restarts after
beginning the process.
iLife ‘11 requires a Mac computer with an
Intel processor, 1GB of RAM, Mac OS X 10.6.3
or higher, and 5GB of disc space. In
reality, our upgrade required just over
4.2GB. As with previous versions, you
can pick which applications you want
to install, and which you don’t, cutting
down on installation time and
disc-space use. This year’s version
cannot be installed on machines
running Leopard, so you’ll have to
upgrade to the latest point release of
OS X to put iLife ‘11 on your machine.
Continued on page 6—
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iWeb, continued from page 5
iPhoto—
iPhoto continues to live on as Apple’s consumer-oriented photo-editing software, second
only to Aperture, which shares many of the
same features, but is aimed at professional
photographers. iPhoto, along with iMovie,
GarageBand, iDVD, and iWeb, make up iLife as
a suite of software that can be used to
manage, edit, and share digital media.
iPhoto ‘11 hasn’t changed much since the
‘09 version of the suite. Its core user interface
remains largely unchanged except for an
optional unified full-screen mode (letting you
view events, faces, places, and your albums
with fewer visual distractions) and more
opportunities to share your work via Facebook
or e-mail.
Veteran iPhoto users will enjoy iPhoto
‘11’s thoughtful tweaks to the editing tools
and the slideshow maker. Editing now gets
handled in a sidebar that breaks down tasks
into “quick fixes” and “effects,” but keeps the
“adjust” menu from previous versions. This
tabbed interface makes it easy to hop around
to different settings--a substantial change from
the previous method, which had all of the
controls underneath your photo or in small,
floating menus. Though the new system takes
up more screen real estate than the old one,
it makes for less mucking about with menu
placement.
The slideshow editor now has twice as
many themes as iLife 09’s version. The new
themes, which include two variations of a
3D-ish hanging mobile, an aged look called
Vintage Prints, folding picture origami, and a
GPS-friendly theme called Places, all take advantage of Apple’s Core Animation technology
to bring some smooth-looking effects to your
photos.
Out of the bunch, the Places slideshow is
one of the most visually interesting additions.
The slideshow scours the GPS data in your
photos and downloads corresponding map
tiles, then places your photos on top of these
maps and adds a neat zooming effect as you
move from place to place. This is a good way
to encourage people to Geotag their photos,
which is done automatically on some cameras
(including the iPhone), but which can also be
done after the fact using iPhoto. See photo at
top right.
iPhoto ‘11 also gives sharing a healthy
boost. Facebook integration, introduced in the
previous version of the software, now runs
much deeper. Besides allowing you to post a
shot to a Facebook album, you can also very
quickly post to your wall, make a new album,
or make a shot your profile picture. However,

you still need to log in to Facebook back on
your browser to do things like reply to comments from other users.
Apple has also revamped iPhoto’s photo
e-mailing tool, which now mimics what you’d
find in its iOS mobile software. Now, if you
want to e-mail a photo, you compose your
message right in the iPhoto software so that
you don’t have to fire up the standalone Mail
application. This works with all the same e-mail
services you get in the standard mail
application, including Windows Live Hotmail,
Gmail, Yahoo Mail, and AOL Mail. You can
even set up your e-mail account credentials
from one of these places from within iPhoto.
We can only hope more of Apple’s applications adopt this simple addition.
Analog sharing has also been improved
with a totally new bookmaking experience.
To aid in book creation, Apple now uses its
face-finding and photo-rating technology to
help pick what photos belong in what parts of
a book. For instance, if there’s space in a book
for a shot that spans two pages, iPhoto will
automatically pick a photo that’s rated highly
and does not have people in it. It also breaks
out photos from different days into different
sections of the book, which is a small, but nice
organizational touch for creating books of long
trips.
iPhoto now also lets you print cards
through Apple’s printing service. These run the
gamut from flat and folded photo cards, to the
more expensive, but quite pretty, letterpress
cards. No matter which version you pick, they
can be customized and previewed within
iPhoto, and ordered the same way as books.
One thing to note here is that you are still
limited to printing out your work through
Apple, and not through third parties, as you

s

The new Places slideshow theme in iPhoto
grabs GPS data from your shots to put together
a visually engaging slideshow.

can with plug-ins in Aperture. And unlike Aperture, with iPhoto you still aren’t able to export a
photo book as a PDF, which is a shame.
Notably missing from the printing equation
are calendars, a popular item from previous
versions of the program that Apple says will
be re-added in a future software update. If you
want to retain the capability to make calendars
in iPhoto, you’ll need to use an older version.
In the meantime, Apple hangs onto existing calendar designs when you upgrade the
software.
iPhoto continues to compete against a
handful of competitors, notably Google’s
Picasa, which is offered up for free on both
the Mac and PC, as well as a beta version
for Linux users. This year’s iPhoto additions
arguably give it the edge in continuing to offer
a more full-screen photo-viewing experience,
and deeper online integration out of the box.
That said, Google’s integration of Picasa Web
albums and the recent addition of Picnik’s online photo editing mean you can do a lot more
with your photos even when you’re away from
your computer.
iMovie—
Much like iPhoto, this year’s version of iMovie
looks a lot like the old one, but with the addition of some extra creative options, the biggest
being movie trailer templates. These templates
help you create short, thematic videos of
friends, much like what you’d see in theaters.
Other additions include sound-editing tools, a
people finder that does a good job at spotting
when people are in your shots, and new effects tools. — continued on page 7
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iWeb, continued from page 6 —
New to iMovie ‘11 are surprisingly fun to use
movie trailer templates (right).

Movie trailers now exist alongside project
themes, and as with the themes, the trailers
provide a quick preview of what your movie
will look and sound like with an example
provided by Apple. Unlike basic themes, trailers are custom-tailored for a specific number
of people based on how many the template
has been made for. This runs from one person, all the way to six. You can, of course, go
off script without the program chiding you.
Each template breaks down what kinds of
clips you need, as well as how many people
you need for each shot. A people detector
scans your video to see who’s in it and figures
out how much of a person is in a shot based
on how close you are to them, which is very
helpful considering some shots are scripted for
close-ups, whereas others need something farther out. Just like the image stabilizer, running
the people finder tool on your videos can take
some time, but if you plan on making movie
trailers, it’s well worth it.
We found trailers easy to create, as long as
you have the right source footage. If you keep
in mind that you might want to make a trailer
while you’re out shooting, you can plan those
shots ahead of time. Even so, once iMovie
has scanned your footage, you can turn just
about anything into a trailer, even if it’s slightly
off from the storyboard. Expect to see a ton of
these on YouTube.
What may end up being a much more
well-used feature than movie trailers for most
people are the new audio-editing controls,
which Apple says was the top user-requested
feature. This has been introduced to the
program quite gracefully, with a button to
toggle them on and off, and an audio
waveform that highlights sections that are too
loud. Balancing these high levels can be done
in one of two ways: either dragging down the
main volume for an entire clip, or selecting the
segment of the waveform you want to change,
and moving the level up and down.
Alongside the audio adjustments are a fun
set of 20 audio effects that can be added to
just one section of your audio, or the entire
movie. These range from the rather mundane
of making people sound like they’re on a
telephone or a shortwave radio, to giving them
a robot or alien voice. You can also adjust their
pitch up or down, which lends itself well to
video high jinks.
This year’s iMovie brings with it a few more
visual effects and two new themes: one for
sports and another for a news event. Much like

the movie trailers, the themes include templates that let you add in things like reporter
and player names that pop up as onscreen
overlays. The new special effects join existing
effects and transitions, and offer up instant
replays, flash and holds, and jump cuts at
music beat markers. This last one is one of the
most fun to use, as you can create markers
that match up to your background music.
This only takes a few seconds to set up, and
has a neat end effect. We can easily see the
replay feature getting much more use, though,
especially for parents who use the sports template, or people making videos of friends and
family members wiping out.
When it comes time to export your
masterpiece, iMovie provides a handful of
new, online options to join Facebook, YouTube,
and MobileMe. Video hosts Vimeo and CNN’s
iReporter require a log-in, then give you
service-specific options on privacy, export
quality, and categorization.
GarageBand
GarageBand remains one of the most creative
tools in the iLife suite, and the ‘11 version
follows suit. New to this year’s version are
features that better teach you how to play, as

well as fix any mistakes you might have made
when using it as a music editor.
Apple has introduced Flex Time and
Groove Matching, both of which let you make
quick corrections to the timing on your
recordings. Many more features are included
but space doesn’t permit detailing them all.
Conclusion—
Though this iteration of iLife may not have
the flash of some previous releases, it
brings each of the updated applications
closer to professional-grade software-editing tools without making them
unnecessarily complicated. If you’re a
frequent iPhoto user who does a lot of
sharing, the updated Facebook and
e-mail enhancements are must-haves; with
iMovie’s new movie trailer feature, you can
turn scattered bits of vacation footage into
something truly compelling that friends
and family will want to watch. GarageBand’s updates also bring a number of pro
quality features to the table, while offering
people who have little to no musical
training easier ways to learn how to play.
Click here for complete review. m
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OMUG Meeting Information—
The Ocala Mac User Group meets on the
2nd Tuesday of the month at the
following location to the SE of Ocala:
St. George Anglican Cathedral—
Parish Hall
5646 SE 28th St., Ocala, FL 34471
(352) 624-0112
See www.ocalamug.org for a map
OMUG Board of Directors—
President– N.C. Sizemore
ncsizemore@gmail.com • 291-8778
Vice President– Dr. Roberto Putzeys
rputzeys@cox.net • 873-3218
Secretary– Nancy Kirby
nkirby1944@embarqmail.com
Treasurer– Judy Rankin
judyrankin@mac.com • 821-2322
Director– Philip Davis
p.davis@ocalamug.org • 369-8432
Director– Burt Stephens
burtstephens@gmail.com • 873-6177
Director– Al Sypher
aes@imageocala.com • 237-9501
Director– position open
Past President– Tim Rankin
rank.tim@gmail.com • 821-2322
Mac Users Helping Mac Users—
OMUG volunteers will try to help with
your computer and software problems.
Please add your name to this list if you
are willing to share your expertise with
other OMUG members.
General Mac Problems– Tim Rankin
rank.tim@gmail.com • 821-2201
Print Shop or Print Explosion–
Judy Rankin
judyrankin@mac.com • 821-2322
General Mac Problems— Web Design
Philip Davis (email ONLY)
p.davis@ocalamug.org
OMUG Assignments—

OCALA MACINTOSH USER GROUP — MEETING MINUTES: October 12th, 2010
The meeting was called to order by Phil Davis at 7pm.
Announcements and Introductions: Phil welcomed members and guests. Shelley Sizemore
is recovering from shoulder surgery and doing fine. We had four guests, including Don and Sandra
Morrison and J.P. Leemans who all joined the group.
Secretary’s Report: The September meeting minutes were accepted with no changes.
Treasurer’s Report: Judy Rankin reported that as of October 12th, the bank balance is $1636.58.
Program Topic: Using Final Cut Pro Suite in Marion County Schools— Speaker, Bill Krysalka
Program Highlights: What a great presentation! Bill reported that most schools are using Dell
computers thanks to Bill Gates and Microsoft, but he has had many requests from students for Mac
assistance with their presentations. Bill and his students use Macs for their presentations utilizing
Final Cut Pro. This program costs $950.00 but there is a less expensive version (less than $200) for
those who are interested. Students are schooled in their knowledge of video shooting, composition
and digital editing. Final Cut Pro offers certification to anyone who passes their exam which means
familarity with all three methods of performing every task. Two students presented their award winning videos: Kaleb Higgins, on teen suicide and Kayla Tumey on eating disorders. Both were very
professional and moving.
Mac Tips: Judy Rankin gave a fine presentation on using iDataBase. This is a program that will store
your important information such as; lists of valuables, important dates and notes.
Mac Tips: Phil’s workshop was well attended on Saturday following the general meeting. It appears we may need to find larger accommodations. Topics included System Preferences, track pad
changes and updates. A complete list is on Phil’s web site and can be accessed through the OMUG
website. Question about using POP mail on Yahoo: POP mail is not supported by Yahoo, but Google
mail does support it. Phil reports that Chrome browser is faster than Firefox and easy to set up.
Next Meeting Presentation: Tim’s Timely Tips, by Tim Rankin. You won’t want to miss this one.
Miscellaneous News: Members enjoyed refreshments, planned and served by Ed Jaworoski and
Della Marteny.
50/50 Raffle Winners:
Tim Rankin. $14.
J.P. Leeman, $14.
Phil Davis, iPhone Photography & Video for Dummies.
Don Morrison, i-DataBase program.
Members only drawing: No drawing this month.      
Attendance: Twenty-two members. Four guests.
Meeting adjourned at 9:00 PM.
Many thanks to members who stayed to help straighten up the room.
Respectfully submitted by:
Nancy Kirby, OMUG Secretary

Assist. Secretaries– Sally Smyth and
Shelley Sizemore
Fifty-Fifty Raffle– Earl Satterfield
Membership– Nancy Kirby
MUGSHOT Newsletter– Al Sypher
Program Coordinator– Burt Stephens
Refreshments– Della Marteny and
Ed Jaworowski
Sunshine Lady– Virginia Baldwin
vbaldwin@atlantic.net • 629-6308
Webmaster and
Apple Ambassador– Philip Davis

Quote For The Month—
“I am always doing that which I can not do,
in order that I may learn how to do it.”
	 — Pablo Picasso
Disclaimer—
The Apple logo is the property of Apple, Inc. The Windows logo is the property of Microsoft, Inc. All tradenames, trademarks, and registered
trademarks used herein are the property of their respective owners or companies. The information presented in this newsletter is for the
personal enlightenment of OMUG members and friends, does not constitute an endorsement, and is not to be used for commercial purposes.
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